# Quick Start Guide

<table>
<thead>
<tr>
<th>Start-Up</th>
<th>Shut-Down</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5</td>
</tr>
</tbody>
</table>

## Quick Guide to Getting an Image

<table>
<thead>
<tr>
<th>Place the sample on the microscope</th>
<th>Finding the sample – transmitted light or DIC</th>
<th>Brightfield vs. DIC</th>
<th>Finding the sample – epi-fluorescence</th>
<th>Finding the sample - confocal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Setting Up for Confocal Microscopy

<table>
<thead>
<tr>
<th>Choosing the Dye</th>
<th>Changing the Dye Selection</th>
<th>Confocal acquisition controls</th>
<th>Settings for the fluorescence detectors</th>
<th>Additional detector controls</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line Selection</th>
<th>Line availability, Figure 7.2</th>
<th>Laser Power Selector, Figure 7.3</th>
<th>Scroll List, Figure 7.4</th>
<th>Line Settings, Figure 7.5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scan Controls</th>
<th>Scan Mode, Figure 6.1</th>
<th>Dwell Time, Figure 6.2</th>
<th>Scan Regions, Figure 6.3</th>
<th>Image Aspect Ratio, Figure 6.4</th>
<th>Box Size, 6.5</th>
<th>Box Size effect on resolution</th>
<th>AutoHV, 6.6</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scan Area Controls</th>
<th>Field of View, 8.1</th>
<th>Scan Area, 8.2</th>
<th>Scan Rotation, 8.3</th>
<th>Scan Zoom, 8.4</th>
<th>Reset Scan Values, 8.5</th>
<th>Scan Offset, 8.6</th>
<th>Use of Sequential, Simultaneous and Averaging</th>
<th>Simultaneous Capture versus Sequential Capture</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

May 11, 2011
Optimizing Image Collection

V.M. Bloedel Hearing Research Center, Core for Communication Research
Center on Human Development and Disability, Digital Microscopy Center

Scan mode and sequential capture ................................................................. 22
Using Channel Groups, Figure 9A ................................................................. 22
Adjusting the channels with sequential imaging .......................................... 22
Adjusting the channels with simultaneous imaging .................................... 22

Collecting a Z-Series .................................................................................. 23
Determine the depth of the optical volume ................................................. 23
Which way does the focus move? ................................................................. 23
Settings for z-series collection .................................................................... 25
What is axial resolution? ............................................................................. 25
Vertical Sections ......................................................................................... 26

Files: Saving and Transferring ................................................................... 26
Saving Files ................................................................................................. 26
The Olympus “OIB” format ........................................................................ 26
The Olympus “OIF” format ......................................................................... 26
Where are Your Files on the Confocal? ...................................................... 27
Export file types ......................................................................................... 27
Add a scale bar to your file ......................................................................... 27
Opening your Files .................................................................................... 27
Olympus free file viewer ........................................................................... 28
Offline Fluoview workstation ................................................................. 28
Importing Olympus datasets into ImageJ .................................................... 28
Loci-tools Plugin for ImageJ ........................................................................ 28
Import Channel Order Macro ...................................................................... 28
Image 5D plugin ......................................................................................... 28
File Import from the OIF.Files directory .................................................... 29
File Transfer ............................................................................................... 29
File transfer to Mac Pro ‘Fluoview’, confocal file server ......................... 29
Saving files directly to Mac Pro ‘Fluoview’ ................................................. 29
USB and Firewire Ports on the Mac Pro ..................................................... 29
Recording to CD-ROM and DVD-ROM on the Mac Pro ......................... 30
Networked file transfer to remote servers from the Fluoview Mac Pro .... 30
Using FTP to Windows computers ............................................................ 30
Remote access to the Mac Pro from your laboratory ................................. 30

Optimizing Image Collection .................................................................... 31
Qualities of an Optimal Confocal Image ..................................................... 31
Overview of image capture properties ....................................................... 31
Overview of basic image capture ............................................................... 31
Basic settings for confocal microscopy ...................................................... 31
Labeling Controls ...................................................................................... 32
Negative controls ..................................................................................... 32
Positive controls ....................................................................................... 32
The confocal aperture ............................................................................... 32
Optimal Iris Diameter ............................................................................... 32
FV-1000 Optical Specifications

No Image! 

Start-up problems.

Scans, but no image.

The confocal image appears unevenly illuminated:

The epifluorescent or tungsten images appear unevenly illuminated:

**Figures**

**Figure 1.** Main Fluoview window. 6

**Figure 2.** Enlarged view of Fluoview windows. 8

**Figure 3.** Microscope Controller Window 9

**Figure 4.** Image Acquisition Window – Basic controls for Finding the Image 11

**Figure 5.** Channel Settings for the Photomultiplier Tube (PMT) 14

**Figure 6.** The Scan Mode and Scan Size settings of the Acquisition Setting Window. 16

**Figure 7.** Selecting laser lines and setting laser power 15

**Figure 8.** Scan Controls for Zoom, Pan and Rotation 19

**Figure 9.** Sequential Imaging Control 20

**Figure 9A.** Sequential Imaging Control 20

**Figure 10.** Z-Series Control Window 24

**Figure 11.** Z-Series Control Window 24

**Figure 12.** DIC and Focus Controls, Lower Half of the Microscope 40

**Figure 13.** Condenser and DIC Controls 42

**Figure 14.** Tilting the condenser. 43

**Figure 15.** The Stimulus Setting window for photoactivation 45

**Figure 16.** Photobleaching an ROI. 46

**Figure 17.** The toolbar item for control over display color 47

**Figure 18.** Fluoview appearance in Darkroom Color 47

**Tables**

**Table 1.** Mirror Buttons 10

**Table 2.** Objective Lenses Available 12

**Table 3.** Scan Speed and Acquisition Time 14

**Table 4.** Optimal Z-Step Values 37

**Table 5.** Pixel Size (µm) versus Box Size and Magnification at Zoom = 1 39

**Table 6.** Dichroic Mirrors and Barrier Filters 38

**Table 7.** Laser Lines on the FV-1000 38

**Table 8.** Index of Refraction for Common Mounting Materials 49
Quick Start Guide

A. Start-up:
All items are lettered in the order in which they are to be turned on.
1. Enter your name and session into the Olympus FV-1000 web calendar;
2. Turn on items labeled with letters:
   (A) Turn on mercury lamp, if needed - power supply is on shelf over monitor;
   (B) Turn on system controllers – press black switch on power supply on right side of air table, next to the computer.
   (C) Turn on power to lasers – press the switch on power strip under shelf behind confocal (beneath the lasers) (405 nm, 561 nm, 633 nm);
   (D) Fire up the DPSS laser (561 nm) – press the green button;
   (E) Turn on Argon ion laser – turn the key to “ON” (458 nm, 488 nm, 514 nm);
   (F) Turn on computer, black tower to right of confocal, press round button to right of floppy;
      a. Windows user name is “Administrator”
      b. password is “fluoview”
3. Double-click on the Fluoview icon, left side of computer monitor desktop, “FV-10ASW”;
4. Choose your name from the users list and enter your password;
   NOTE: Fluoview user accounts open with the last settings used by the previous user.

B. Shut down:
1. Transfer files from your account (See File Transfer, Section );
2. Exit from Fluoview;
3. Ignore the warning about light coming through the microscope.
4. Turn off power strip (B);
5. Turn off power strip (C);
6. Turn off argon ion laser (E), key only;
7. Delete images from the hard drive;
8. Turn off the computer;
9. Remove immersion oil from objectives, clean the stage and platform.
10. Edit time in the web calendar, if you went longer than reserved.

Keys versus Switches.
Use the key to turn the argon laser on and off. Do not use the power switch – that will prevent the fan to run during cooling down and potentially damage the laser.

For components controlled by power strips (B, C, D), do not fiddle with the keys or switches on the actual components. The exception is that the 561 nm laser (D) needs its green button pushed to turn it on, but it is turned off by the power strip (C), along with the other 2 lasers.

If the building power fails, backup batteries will provide about 10 minutes to turn off all components.

May 11, 2011
1. Quick Guide to Getting an Image

Examples of the software control windows are on the following pages. The text contains numbers that refer to specific numbered controls in figures.

Your overall goal with fluorescent microscopy is to image the specimen with the least amount of photobleaching. This requires limiting specimen exposure to damaging levels of excitation light.

1. Find the specimen using the eyepieces and epi-fluorescence. This is faster than scanning.
2. Low magnification objectives allow rapidly searching over large areas, but usually dimmer.
3. Low intensity transmitted light is safest for finding and positioning the sample.
4. DIC is usually better than brightfield for low contrast samples, such as monolayers or picking out structures in complex specimens.
5. Epi-fluorescence is usually faster than confocal to find the fluorescent sample.
6. Epi-fluorescence allows you to see a blurry glow from out of focus objects, unlike confocal.
7. Use the least amount of light necessary to find the sample to reduce photobleaching and toxicity.
8. Begin confocal imaging using low laser intensity with high PMT HV while surveying the sample.
9. Focusing on the edge of the coverslip by transmitted light can help to find initial focus.

Figure 1. Main Fluoview window.
1.1 Place the sample on the microscope

1. Make sure the objective lens is not extending above the level of the specimen holder;
   a. If it is, rotate the focus knob to lower the objective lens (set to Coarse Focus)
2. Press ‘ESC’ button behind either focus knob to lower the objectives;
3. Move the condenser up, out of your way;
4. Install the appropriate specimen holder in the stage, if needed;
5. Place the slide on the stage with the coverslip downwards;
6. The sample should be centered in the stage opening to avoid bumping the sample holder with the lens as you move the stage to position the desired field of interest;
7. Press ‘ESC’ button to return the lens to focus;
8. Lower the condenser back into position;
9. **Do not use the keypad** on the front of the microscope, it has been disabled;
10. All microscope control must be through the Fluoview software windows, Figures 2, 3;
11. **Open the Microscope Controller window**, if it is not open: Fluoview menu>Device>Microscope Controller…, Figure 2.1;
12. **Select an objective**: Microscope Controller Window>Objective Lens>click on desired lens, Figures 2.4 and 3.2, see Table 2;
13. **Condenser setting**: Microscope Controller Window>Condenser sets condenser automatically – don’t touch, Fig. 3.1;
14. **Select mirrors** (fluorescence filter cubes): Microscope Controller Window>Mirror>click on desired mirror, Fig. 3.3, see Table 1;
15. **Fine focus/coarse focus**: press the ‘F/C’ button below each focus knob, Figure 12.2, to toggle between focus modes;
16. Lower/raise lens to apply immersion oil: press the ‘ESC’ button behind each focus knob, Figure 12.3;
17. Center the region of interest in the field of view with the joystick;

1.2 Finding the sample – transmitted light or DIC

1. Center the sample over the stage opening to avoid bumping the stage with the lens;
2. Refer to **Microscope Controls**, Sections 7.2 and 7.3, for details on using DIC and setting Koehler illumination;
3. Open the Microscope Controller window, Fluoview menu>Device>Microscope Controller…, Figure 2.1;
4. **All microscope control** must be through the Fluoview software windows, Figures 2.1, 2.4;
   a. Select lens: Microscope Controller Window>Objective Lens, Figure 3.2, Table 2;
   b. Condenser controls are set automatically: Microscope Controller Window>Condenser – don’t touch, Fig. 3.1;
   c. DIC condenser settings are automatically selected when transmitted lamp is on: Microscope Controller Window>Mirror>Select DIC (DICT), Fig. 3.3;
5. Turn on the transmitted light;
a. Image Acquisition Control Window>Click on transmitted light, Figure 4.1;
b. Image Acquisition Control Window>adjust brightness (TR Lamp) (click or scroll), Figure 4.4;

6. Bring sample into focus;
7. Set Koehler illumination [optional, Section 7.3];
8. Center the region of interest in the field of view;
9. Turn off the transmitted light with the Image Acquisition Control Window, Figure 4.1;
10. Switch to fluorescent imaging.

Remove the DIC analyzer from the light path for optimal confocal images!

Figure 2. Enlarged view of Fluoview windows.
1.3 Brightfield vs. DIC
The default setting for plain brightfield imaging is with the condenser DIC prism in place, “DICT”. True brightfield illumination is obtained by removing the condenser polarizer and analyzer from the light path then selecting a “--” setting for the condenser in the Microscope Controller window. Refer to section 7 for more information.

1.4 Finding the sample – epi-fluorescence
1. Sample should be brought into focus and centered, as described above;
2. Open the fluorescent shutter
   a. Image Acquisition Control Window>Click on the fluorescent shutter button, Fig. 4.2;
   b. The Microscope Controller will switch to the last filter used;
3. Select fluorescence filter, if desired
   a. Microscope Controller Window>Mirror>click on ‘DAPI’, ‘FITC’ or ‘TRITC’ (blue, green or red fluorescence), Fig. 3.3, Table 1;
4. Adjust focus and stage to position sample;
5. Adjust fluorescent intensity with the aperture lever on the mercury lamp;
6. Close the mercury lamp shutter
   a. Image Acquisition Control Window, Fig. 4.2;
   b. System will switch to ‘LSM’;

Figure 3. Microscope Controller Window
<table>
<thead>
<tr>
<th>Mirror Button</th>
<th>Function</th>
<th>Mode</th>
<th>Visualization</th>
</tr>
</thead>
<tbody>
<tr>
<td>LSM</td>
<td>Confocal Imaging</td>
<td>Confocal</td>
<td>Confocal only, automatic</td>
</tr>
<tr>
<td>DAPI</td>
<td>UV excitation</td>
<td>Epi-fluorescence</td>
<td>Eyepieces only</td>
</tr>
<tr>
<td>FITC</td>
<td>Blue excitation</td>
<td>Epi-fluorescence</td>
<td>Eyepieces only</td>
</tr>
<tr>
<td>TRITC</td>
<td>Green excitation</td>
<td>Epi-fluorescence</td>
<td>Eyepieces only</td>
</tr>
<tr>
<td>Cy5</td>
<td>Red excitation</td>
<td>Epi-fluorescence</td>
<td>Eyepieces or Camera</td>
</tr>
<tr>
<td>DICT</td>
<td>DIC/ Brightfield</td>
<td>Transmitted light</td>
<td>Confocal or Eyepieces</td>
</tr>
<tr>
<td>---</td>
<td>Brightfield</td>
<td>Transmitted light</td>
<td>Confocal or Eyepieces</td>
</tr>
</tbody>
</table>

Table 1. Mirror Buttons

1.5 Finding the sample - confocal

1. **Select the dyes from the Dye List Window** (Section 2.1);
2. **Set collection parameters for minimal photobleaching** – See “Optimizing Image Collection”;
   a. Minimal laser intensity, Acquisition Setting Window>Lasers, [Fig. 7], start with 1%;
   b. set detector HV fairly high ~1000 V, Image Acquisition Control Window (See section 2.7.1 regarding Auto HV)
3. Set the Live View to tile view, each channel is displayed in a separate window;
4. Set to gray scale (control-h);
5. Set scanning to simultaneous (Sequential checkbox, [Fig. 4.9], is cleared);
6. **Initiate scanning**: Image Acquisition Control Window>Focus X2 or Focus X4, [Fig. 4.5];
7. Adjust focus and position of sample;
8. Roughly adjust laser power and HV to reduce saturation;
9. Stop scanning, Image Acquisition Control Window>Stop [Fig. 4.8].
10. **Refer to Section 2** for more information on settings.
11. Select Sequential, Frame, [Fig. 4.9];
12. Select each channel and adjust to minimal laser power and HV less than 750 to avoid saturation (red masked pixels);
13. Set the Offset to see only a few or no pixels of intensity = 0 (blue masked pixels)
14. **Set the dwell time**, 2 or 4 µs are good starting points
   a. Acquisition Setting Window>Fast-Slow slider, [Fig. 6.2];
15. **Scan XY Repeat**, Image Acquisition Control Window, [Fig. 4.6] to preview full resolution;
2. Setting Up for Confocal Microscopy

This section covers basic settings for obtaining a confocal image.

2.1 Choosing the Dye

Each combination of fluorescent labels requires specific laser lines, dichroic mirrors and filters. These are selected automatically when you choose the fluorophores from the list in the Dye List Window.

1. Open the Dye List Window, if it is not currently visible, Fig. 2.5;
   a. click on Image Acquisition Control/Dye List button, Fig. 4.3, to open;
2. Selected Dyes – upper window displays the currently selected dyes
   a. click on “All Clear” to remove all current selections
   b. double-click on any selected dye to remove it
3. Scroll through the list of dyes in the lower window;
4. Select each desired fluorophore by double-clicking on the name;
   a. if your particular dye does not appear in the list, contact facility manager, or choose one with similar characteristics
   b. dyes with conflicting optical requirements will generate an error message
5. Activate the settings by clicking on the “Apply” button, lower window;
Dye names are written into the image file metadata. However, fluorophores with broadly similar excitation and emission spectra will use the same laser line and filters. For example, FITC, EGFP, Alexa488 and Mitotracker Green will all use the 488 nm laser and a bandpass filter of 500 nm to 550 nm

2.1.1 Changing the Dye Selection

1. Remove a selected fluorophore by double-clicking on the dye name
2. To add a dye
   a. double-click on the new label from the dye list
   b. set the detectors for the new dye by clicking on “Apply”.

Q. My fluorescent stain is not on the list – what do I do? Refer to “Optimizing the Image”.

<table>
<thead>
<tr>
<th>Objective</th>
<th>NA</th>
<th>Working Distance</th>
<th>Immersion</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Lateral</td>
</tr>
<tr>
<td>4X UplanSApo</td>
<td>0.16</td>
<td>13 mm</td>
<td>Air</td>
<td>1.906 μm</td>
</tr>
<tr>
<td>10X UplanSApo</td>
<td>0.40</td>
<td>3.1 mm</td>
<td>Air</td>
<td>0.601 μm</td>
</tr>
<tr>
<td>20X LWD*</td>
<td>0.45</td>
<td>7.8 mm</td>
<td>Air</td>
<td>0.677 μm</td>
</tr>
<tr>
<td>20X UPlanSApo</td>
<td>0.75</td>
<td>600 μm</td>
<td>Air</td>
<td>0.319 μm</td>
</tr>
<tr>
<td>40X UPlanFL N</td>
<td>1.30</td>
<td>200 μm</td>
<td>Oil immersion</td>
<td>0.181 μm</td>
</tr>
<tr>
<td>60X PlanSApo</td>
<td>1.35</td>
<td>150 μm</td>
<td>Oil immersion</td>
<td>0.226 μm</td>
</tr>
<tr>
<td>60X/W collar*</td>
<td>1.20</td>
<td>280 μm</td>
<td>Water immersion</td>
<td>0.254 μm</td>
</tr>
<tr>
<td>100X UPlanSApo</td>
<td>1.40</td>
<td>139 μm</td>
<td>Oil immersion</td>
<td>0.168 μm</td>
</tr>
</tbody>
</table>

Table 2. Objective Lenses Available

*Special purpose, not usually kept on microscope.

*Correction collar allows correction for coverslip thickness and refractive index mis-match.

20X LWD is intended for use with plastic culture dishes.
60X/W lens is used for live tissue or fixed tissue mounted in low RI media such as PBS

2.2 Confocal acquisition controls.

1. **Focus X2, 4.5** - Scans only the odd lines and replicates them, at 2 μs pixel dwell time.
   a. rapidly scanning is very helpful when focusing and moving the stage.
   b. may be used for recording rapid fluorescence changes, such as ion measurements.
2. **Focus X4, 4.5** - Scans alternate odd lines, replicating the scanned lines to generate an image of 4X reduced resolution in the Y-axis, at 2 μs pixel dwell time for extremely fast scanning.
3. **XY Repeat, 4.6** – Scans at full resolution, at the user’s chosen dwell time.
4. **XY, 4.7** – Acquires one image, or defined set of images, using the current settings.
5. **Stop, 4.8** – Stops any scan, retaining the current image in the Live Image Window.
6. **Sequential Acquisition, 4.9** – collect each channel separately, scanning with one laser line at a time.
7. **Confocal Aperture, 4.10** – Controls the diameter of the pinhole.
8. **Kalman Averaging, 4.11** – Allows averaging signals from multiple scans to reduce noise.
9. **Information, 4.12** – Opens a window displaying the current pixel size.

**Focus X2 and Focus X4 settings switch to 2 µs dwell time.** These scan settings reduce resolution in Y axis by 2-fold and 4-fold, respectively. Use these settings with the AutoHV switch selected.

### 2.3 Settings for the fluorescence detectors.

Each fluorophore selected from the Dye List will activate one of the photomultiplier tube (PMT) channels and set its appropriate filters. Three settings control the sensitivity and signal to noise ratio for each detector. Refer to “Optimizing the Image” for details on these settings.

1. **HV, 5.1** – The primary adjustment for the PMT. HV controls the detector sensitivity and amplification.
   a. try to stay below 750, higher settings will introduce detector noise in the image
   b. higher HV may used with averaged images to allow reduced laser intensity

2. **Gain, 5.2** – This multiplies the analog electrical signal created by the PMT by a constant, before it is digitized. While this can provide ‘brighter’ images, the noise and background intensities are increased as well.
   a. leave set to “1” unless working with very low HV settings.

3. **Offset, 5.3** – The Offset will raise or lower all pixel intensities to control the “Black Level” of the image. It should be set so that the darkest values in the image are above zero.
   a. leave set to default values of approximately 5 to 7
   b. set the display to gray scale, pixels with intensity = 0 will be pseudocolored blue
   c. set the Offset so that no blue pixels (intensity = 0) are present

### 2.4 Additional detector controls.

1. **Laser power level, 5.4** - changing from this window may be more convenient than scrolling over to the laser control window.
2. **Active detector check mark, 5.7** – removing this check mark will turn off the channel and its associated laser line.
3. **Group number, 5.5** - allows channels to be grouped for sequential channel acquisition.
   a. channels that do not share bleedthrough, e.g. Alexa488 and Cy5, they can be combined into the same group.
   b. channels in the same group are scanned simultaneously to reduce the amount of time required for sequential acquisition
2.5 Laser Controls.

Each fluorophore selected in the Dye List will select an appropriate laser line and some default intensity setting. The Line Setting values are given as a percentage of full rated output of the laser (mW) entering the scanhead. You can change the power setting for each line or turn lines off to assess bleedthrough (details of bleedthrough are in section 6).

2.5.1 Line Selection.

Active lines are indicated by a check mark, Figure 7.1. Clicking in these boxes will toggle lines between active and blocked. This control blanks the lines in the scanhead, it does not turn the laser itself on or off.

2.5.2 Line availability, Figure 7.2.

Laser lines associated with each set of controls are listed in this column. This list is not affected by a whether or not a laser has been powered up.
2.5.3 Laser Power Selector, Figure 7.3.
These controls regulate the percentage of laser power allowed to pass through the acoustico-optical tunable filter (AOTF) located in the scanhead. Each individual laser has a unique output power. Thus, if all laser lines are set at any given percentage, each will be providing a different amount of energy to the sample.

2.5.4 Scroll List, Figure 7.4.
If there are more lines than can be displayed in the window, scroll through the list by clicking on the black triangles or by dragging the slider.

2.5.5 Line Settings, Figure 7.5
As with other controls, the laser power may be adjusted by clicking anywhere in the control area, scrolling the thumbwheel (1% increments) or by clicking on the black triangles (0.1% increments). Using the thumbwheel to go below 1% will set the laser power to 0%. Use the triangles to increment laser intensities to values between 0% and 1%.

Figure 7. Selecting laser lines and setting laser power
2.6 **Scan Controls**

2.6.1 **Scan Mode, Figure 6.1**

1. Unidirectional - Standard scan mode for routine imaging. Each line is scanned from left to right, the laser beam is blanked while the scanner jumps back to the left side to scan the next line.
2. Bi-Directional – the specimen is scanned in both directions, odd lines are recorded from left to right, even lines from right to left. This allows for extremely fast scanning of brief, rapid events. There is a 30 sec. limit for bi-directional scanning.

2.6.2 **Dwell Time, Figure 6.2**

The Dwell Time is the length of time allotted for the focused laser spot to scan across each sample point in the scan box. A longer dwell time increases the length of time spent moving over each point to deliver more photons exciting the fluorescent label to generate signal. However, a longer dwell time will increase photobleaching. The time required to scan a field is determined by the product of the number of times each line is scanned, number of lines in the field, number of sample points per line and the dwell time. Zoom does not affect scan time.

The numbers below the dwell time slider provide the effect of dwell time on image collection, for example - P:4.0 µs  L:3.144 ms  F:1.644 s  S:4.932 s

![Image of Scan Modes, Dwell Time, Scan Regions, Box Size, Image Aspect Ratio, Auto HV](image)

**Figure 6.** The Scan Mode and Scan Size settings of the Acquisition Setting Window.
Scan Time per Line (L) is determined by Dwell Time (P) X length (e.g. 512, 1024, etc.) plus the “flyback” time required to return the laser spot to the start of the next line. The time to record a Frame (one image, F) is L X number of lines in the box size. The Set (S) is F X the number of scans required to record each 2D image plane. S = F for simultaneous collection, but S = F X # channels for sequential acquisition. Kalman averaging will increase scan time by the number of averages, and a z-series will increase S by the number of focus steps (F X z-steps).

2.6.3 Scan Regions, Figure 6.3.

These buttons select the type of region to scan.

The leftmost “Normal” rectangle defines the scanned region as the selected box size. The Polygon options allows user-defined regions within the box. These may be rectangular, circular or irregular polygons. The laser beam is blanked outside of the selected scan region.

The ‘Line’ and ‘Point’ options are specialty scans that may be used for creating a “vertical” section by scanning through a focus range or to record rapid dynamic processes, such as calcium spikes. All of the scan regions may be used for techniques such as photoablation, photoactivation or photobleaching.

2.6.4 Image Aspect Ratio, Figure 6.4.

The default scan region is 1:1 (width:height), or square. The “4:3” option provides rectangular boxes, e.g. 768 X 512. The “arbitrary” option allows the user to define any needed box, e.g 129 X 17.

2.6.5 Box Size, 6.5.

Box Size controls the “sampling density” of the image, the number of sampling intervals in the X-axis and Y-axis of the scanned field. The scanned region will be divided into the stated number of lines with each line divided into the selected number of sample points. In turn, the acquired image will possess corresponding dimensions, in pixels.

Table 3. Effect of Scan Speed and Box Size on Acquisition Time - single plane, 3-channel image

<table>
<thead>
<tr>
<th>Dwell Time per Pixel (P:)</th>
<th>Box Size</th>
<th>Scan Time Per Line (L:)</th>
<th>Seconds per Frame (F:)</th>
<th>Time for Set (S:)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0 µs</td>
<td>512X512</td>
<td>1.572 ms</td>
<td>0.822 s</td>
<td>2.446 s (Sequential)</td>
</tr>
<tr>
<td>2.0 µs</td>
<td>512X512</td>
<td>1.572 ms</td>
<td>0.822 s</td>
<td>0.822 (Simultaneous)</td>
</tr>
<tr>
<td>8.0 µs</td>
<td>512X512</td>
<td>6.288 ms</td>
<td>3.288 s</td>
<td>9.862 s (Sequential)</td>
</tr>
<tr>
<td>8.0 µs</td>
<td>512X512</td>
<td>6.288 ms</td>
<td>3.288 s</td>
<td>3.288 s (Simultaneous)</td>
</tr>
<tr>
<td>4.0 µs</td>
<td>1024X1024</td>
<td>6.288 ms</td>
<td>3.288 s</td>
<td>9.862 s (Sequential)</td>
</tr>
<tr>
<td>4.0 µs</td>
<td>1024X1024</td>
<td>6.288 ms</td>
<td>3.288 s</td>
<td>3.288 s (Simultaneous)</td>
</tr>
</tbody>
</table>

Olympus Fluoview-1000 User’s Guide
V.M. Bloedel Hearing Research Center, Core for Communication Research Center on Human Development and Disability, Digital Microscopy Center

May 11, 2011 17
2.6.6 Box Size effect on resolution

The resolution of an image is determined by dividing the scanned field by the box size to set the area represented by each pixel in the final image. Dividing the field into fewer sample points requires that each sample point will encompass a larger area. Conversely, doubling the box size (e.g. from 512X 512 to 1024X1024) reduces the area of each sample point by 2-fold. However, a 2-fold increase in the box size will also give a 4-fold increase of the file size because this is an area (width X height).

The box size and zoom setting (section 2.10) are used together to control the size and resolution of the scanned region for any selected lens.

Refer to the later section on Optimizing the Image.

2.6.7 AutoHV, 6.6.

This only needs to be set once after a user account is established. If you don’t activate the Auto HV setting, then every time laser and HV are set with a selected dwell time (such as with Scan X2 or Scan X4), switching to a different dwell time may cause your image to become saturated.

1. Begin scanning with Focus X2 or Focus X4 Focus mode and find your sample;
2. Adjust the laser and detector settings;
3. Click on ‘Auto HV’ to set the reference histogram;
4. Switch to Repeat XY or XY to scan with a longer dwell time, e.g. 4 µs;
5. Notice that the HV is reduced to maintain image intensity and prevent saturation.

2.7 Scan Area Controls

This panel controls the scanned area.

2.7.1 Field of View, 8.1.

The circle represents the area imaged by the objective lens. The scanner will record the selected sub-region.

2.7.2 Scan Area, 8.2.

This is the portion of the objective field of view that will be recorded. A square region at Zoom = 1 represents the maximum field, as displayed in figure 8. A Zoom = 2 would scan only the central 1/2 of the area.

2.7.3 Scan Rotation, 8.3.

The scan region may be freely rotated by clicking on the red dot and dragging it around the circle. Clicking on the curved arrows will increment rotation in 0.1° increments.
2.7.4 **Scan Zoom, 8.4.**

This controls the size of the scanned region and the resolution. Click in the slider area to increment scan zoom by 1X increments or click on the arrows to increment by 0.1X increments. Increasing the zoom will reduce the pixel size and the field of view. The rectangular outline in the Scan Area, 8.2, updates to display the scanned region.

![Diagram of Scan Controls](image)

**Figure 8. Scan Controls for Zoom, Pan and Rotation**

2.7.5 **Reset Scan Values, 8.5.**

Return the field Offset and Rotation to “0”, and zoom to “1”. Changing the Zoom is most quickly accomplished by clicking on the Zoom Reset then changing the zoom to the new value.

2.7.6 **Scan Offset, 8.6.**

Move the Scan Area within the Field of View by either clicking on the scan area and dragging it, or by clicking on the sliders and arrows. The only works with a zoom > 1, of course. Be aware that moving the scanned field to an extreme edge of the objective field of view will result in slightly degraded resolution and distortion due to parallax.
Figure 9 – Sequential Acquisition and Averaging Controls

9.1 Sequential Line vs. Frame

9.2 Groups

9.3 Kalman Averaging

9.2A

9.3 Channels

9.3A Grouped Channels

Figure 9A – Sequential Acquisition and Averaging Controls
3. Use of Sequential, Simultaneous and Averaging.

3.1 Simultaneous Capture versus Sequential Capture.
Simultaneous capture collects a multi-channel image by scanning the sample with the laser lines for all selected channels at the same time. The combined fluorescent emission spectra are separated and directed to their respective detectors by a series of dichroic mirrors. The barrier filter at each channel transmits narrow spectrum of wavelengths designated to represent the respective fluorophore with a minimal amount of bleedthrough from other fluorescent labels in the specimen. However, emission spectra from most fluorophores overlap to some degree, especially onto the longer wavelength side of the emission peak. The result is that some emissions from any fluorophore will appear in the adjacent channel(s) on the “red” side of the spectrum.

Sequential capture of multiple channels is accomplished by collecting only 1 channel at a time. The specimen is scanned with a single laser line for each channel and the emission is captured with the appropriate detector. Thus, the image from each label is collected by itself without the presence of overlapping signals from other fluorophores present in the specimen. This eliminates most bleedthrough but, acquisition time is longer and any sample movement will appear as mis-registration between channels. If a laser line also significantly excites other fluorophores, their emissions may overlap sufficiently to cause bleedthrough. As always, control specimens are important.

Sequential is faster than Sequential capture and is commonly used for positioning the sample. It may be “good enough” for routine imaging of samples that exhibit tolerable levels of bleedthrough and is an important tool for recording dynamic events. Sequential capture is slower, but produces images with higher contrast and greater spectral accuracy.

3.2 Two Methods for Sequential Capture

3.2.1 Sequential Line Capture, Figure 9.1
Channels are recorded by sequentially scanning each line in the image for each channel in turn. If 3 channels are to be recorded, then each line is scanned 3 times, once for each channel, and the process is repeated for each line in the image. The advantages of line sequential scanning are that all channels update relatively quickly, as with a merged image, and motion in living cells is minimized between the channels within each line. Sequential line capture is about 10% faster than sequential frame capture.

3.2.2 Sequential Frame Capture, Figure 9.1
The entire field is scanned for only the selected channel and only that channel will be updated in the Live View window. Select the desired channel to image by clicking on its group in the sequential panel.
3.2.3 Scan mode and sequential capture

1. ‘Scan X2’, ‘Scan X4’ or ‘XY Repeat’ - click on the desired channel for Frame scanning. That channel will be scanned until the user clicks on ‘Stop’ or selects a different channel.
2. ‘XY’ scan button will acquire all active channels in the selected sequential manner, and display the result.

3.3 Using Channel Groups, Figure 9A.

A group number is visible in the title bar for each detection channel, Figures 5.7, 9.2, 9.2A. Channels given the same group number will be scanned simultaneously during sequential capture. Any channels that do not display significant bleedthrough, e.g. Alexa 488 and Alexa 660, may be scanned together during sequential capture as shown in Figs. 9.2A, 9.3A. These 2 detectors are set to the same group number and scanned simultaneously while the other channels would be scanned sequentially. The advantage to channel groups is that acquisition time can be reduced during sequential image acquisition. When adjusting detectors using Frame Sequential, selecting a group will scan both channels, Fig. 9.3A.

3.4 Adjusting the channels with sequential imaging

Bleedthrough is commonly encountered with many fluorophore combinations. Channel adjustment is best accomplished by using sequential imaging.

1. Live Window is set to gray scale (control-h) in order to observe saturated pixels;
2. Set Live Window for tile view (each detector is viewed in its own pane);
3. Click on ‘Sequential’;
4. Select ‘Frame’;
5. Click on ‘Group 1’, Figure 9.2;
   a. the channel(s) in this group will be scanned
6. Scan with ‘Scan X2’ or ‘Scan X4’;
7. Adjust PMT settings and laser power for image quality
   a. try to keep ‘HV’ below 750 to minimize detector noise
   b. minimize laser power levels to reduce bleedthrough and photobleaching
8. Click on the next channel group and repeat the process;

3.5 Adjusting the channels with simultaneous imaging

Bleedthrough for some fluorophore combinations can be minimized during simultaneous imaging solely with the laser power and detector settings. In general, strive to minimize the strength of the signals from shorter wavelength fluorophores by reducing the laser power for those channels. This reduces the red side of their emission spectra to reduce their contributions to the signals passing the filters for the longer wavelength dyes.

Conversely, the HV setting for each channel controls sensitivity to any photons transmitted through the barrier filter, regardless of which fluorophore from which they originated.
1. Live Window is set to gray scale (control-h);
2. Set Live Window for tile view (each detector is viewed in its own pane);
3. Turn off ‘Sequential’ imaging (clear the check box);
4. Click on ‘Scan X2’ or ‘Scan X4’;
5. Choose the channel with the lowest excitation wavelength;
6. Reduce the laser power to the lowest possible level while adjusting ‘HV’, keeping below 750, until an acceptable image is obtained;
7. Select the next channel and adjust the appropriate laser power as low as possible but, take care in adjusting the HV so that the shorter wavelength channel does not contribute significantly to the image;
8. The channel with the longest excitation wavelength can be adjusted to a low HV and a relatively higher laser intensity to reduce amplification of bleedthrough from the other fluorophores;
9. Acquire your images.

See Section 6, ‘Optimizing your images’ for details on setting the detectors.

4. Collecting a Z-Series.
A z-series is a set of images collected with an increment of focus between each image plane. This is an automated process where the user sets the upper and lower limits of the focus travel with an interval for incrementing the focus between captures.

4.1 Determine the depth of the optical volume.
Focus through the sample with Scan X2 or Scan X4 and note either the Current Focus settings (Figure 10.3) or structural landmarks. The focus increment (Step Size) should be approximately one-half the size of the smallest object to be axially resolved, or one-half of the objective lens axial resolution. Each lens has a limit of axial resolution, Table 2. See Optimizing Your Image.

4.1.1 Which way does the focus move?
The objective lens moves in the direction of the back side of the focus knob. To focus “upwards”, through the coverslip and into the sample, turn the knob so the top moves towards you.
Focus “downwards”, towards the coverslip, by turning the knob so the top moves away from you.
Figure 10. Z-Series Control Window

10.1 Lens Objective
10.2 Move Focus to: Start Middle End
10.3 Current Focus Level
10.4 Objective Resolution Limits
10.5 Set Focus to 0

Figure 11. Z-Series Control Window

11.1 Set Focus Limits
11.2 “Optimal” z-Step
11.3 Focus Increment
11.4 # of Slices
11.5 Clear Start/End
11.6 Step Focus
11.7 Step the Center of Z-Series

1/2 Step, Full Step
4.2 **Settings for z-series collection.**

1. Determine the axial extent of volume needed (how far you need to focus through the sample);
2. Focus to lower extent of volume by manual focus or by the large yellow arrowhead pointing downwards, Figure 11.6, (increments focus by the Step Size);
3. [Optional] Use the small downwards arrowhead to finely establish the volume limits, Figure 11.6 (increments focus by 1/2 Step Size);
4. Click on the ‘Set’ for the “End” (lower) limit, 11.1;
5. Establish the upper extent of the volume and click ‘Set’ for the “Start” limit, 11.1;
6. Set the StepSize, Figure 11.3, by one of 3 manners:
   a. enter a value (µm) and press the ‘Return’ key
   b. click on the small black arrowheads
   c. Click on ‘Op.’ to select an “optimal” value calculated from the objective lens and wavelength, Figure 11.2
7. The number of optical slices will appear in box 11.4;
8. Move to the XY acquire button, Figure 4.7;
9. Select ‘Depth’, Figure 4.7;
10. Click on the XY acquire button to collect the z-series, Figure 4.7;
11. When the series is completed, you will be prompted with 2 options:
    a. “Series Done” – click here if you are content with the results
    b. “Append” – click on this to add sections to the end of the z-series, the number of sections to append is controlled by the box next to the button

The red number below the lens icon in this window displays the current axial position. You can simplify keeping track of focus distance by clicking on the ‘Set 0’ button before beginning to scan or set focus limits. This will set the current axial position to “0” and subsequent focus positions will be displayed relative to this position.

4.2.1 **What is axial resolution?**

Axial resolution describes the smallest depth interval that can be resolved by the lens, it depends on the lens NA, emission wavelength and quality of the specimen preparation. Air lenses have roughly 3-5 times lower axial resolution than lateral resolution while immersion objectives have 2 times lower axial resolution. The optimal setting button sets the z-step to 1/2 of the calculated axial resolution. The 20X/NA 0.75 air lens has calculated axial resolution of 2.32 µm, for a calculated optimal z-step of 1.16 µm. In practice, smaller z-steps, down to 0.4 µm result in higher quality images for this lens. Images collected for deconvolution, benefit from “over-sampling” in the z-axis by a factor of 2, or using a z-step that is at least 4 times smaller than the calculated axial resolution.
4.3 **Vertical Sections.**
This is a type of z-series that produces optical equivalent of a 2-dimensional cross-section through your sample. A series of scans are collected along a single line while incrementing the focus between each line. The resultant image represents a vertical “slice” taken through the volume where the first (top) line of the image represents the top of the volume and each successive line represents a line scanned at successive depths through the volume.

1. Determine the extent of the volume to be collected, as described above;
2. Set the necessary z-step increment, as described in section 4.2;
3. Scan an image at some level displaying structures to guide orienting the line;
4. Select the ‘Line’ scan region, Figure 6.3;
5. Draw the line across the image in any desired orientation;
6. The line may be re-positioned in x,y and position of its ends;
7. Move to the XY acquire button, Figure 4.7;
8. Select ‘Depth, Figure 4.7;
9. Click on the XY acquire button to collect the z-series, Figure 4.7;

5. **Files: Saving and Transferring**

5.1 **Saving Files**
Olympus created 2 proprietary file formats for images collected on their confocal microscopes. Both formats record all meta-data, regions of interest and preserve the original 12-bit (4096) image intensity values. Each format has its benefits and drawbacks.

5.1.1 **The Olympus “OIB” format.**
This format writes all images and meta-data to a single file. Some software applications, such as Slidebook for Windows, Imaris (Bitplane) and the LOCI plugin for ImageJ have incorporated the ability to read the .oib format. The OIB format is not widely supported. If you do not have software to open this format, your images cannot be accessed.

5.1.2 **The Olympus “OIF” format.**
Each acquisition saves both a folder and a file. The naming convention is “filename.oif.files” and “filename.oif”, respectively. The “filename.oif” is a text file containing metadata. The directory “filename.oif.files” contains the images as a series of 16-bit TIFF images, one image for each channel in each plane of focus, timepoint or lambda scan. The directory also contains an additional “filename.pty” file with metadata regarding the individual TIFFs and some additional non-image files.

The “.oif” format, can be imported in the greatest range of software. It also is compatible with spooling files to disk. It can be opened by Slidebook for Windows, Imaris, ImageJ, LOCI and Huygens.
1. Open the OIF format by choosing the “filename.oif”, not the “filename.oif.files” directory.
2. The OIF format is compatible with spooling files during acquisition of large files >800 Mb.
3. If software is not available to recognize the OIF format, the filename.oif.files folder can be
   opened and the individual TIFF files imported to view your images.

5.1.3 Where are Your Files on the Confocal?
1. Double-click on “My Computer”;
2. Navigate to directory “My Computer/Data(D:/FV10-ASW/Users/Username/Image”;
3. A shortcut for User Files exists on the desktop.

5.2 Export file types.
Any open file may be exported as a TIFF, JPEG or PNG, but this converts images to 8-bits. Conversion
to 8-bits is usually sufficient for presentation, but is not recommended for images intended for
deconvolution, quantification, or any image processing operations such as background subtraction,
feature recognition, etc. Saving files that have been converted to 8-bits does not constitute archival of
primary data. Do not use 24-bit RGB tiff as an archival format, since each channel is scaled to 8-bits.

5.2.1 Add a scale bar to your file
You may add a scale to your file and then export as a TIFF to have the scale bar show up in ImageJ or
Photoshop. However, this means saving your file under yet another format. Adding scale bars in
ImageJ or Photoshop is simple and directions can be found on our website in the section on image
processing software.

1. View the image in Fluoview;
2. Click on the Pencil icon, left of the image window, to get a palette of editing tools;
3. Select the Ruler icon near the bottom of the tools palette;
4. Draw the desired scale bar on your image (hold down the Shift key to obtain lines at 45°
   increments);
5. Select ‘Export’ from the File menu;
6. Select the file format, e.g. “TIFF”;
7. Select the option button for “Selected overlay”;
8. Click on the ruler icon;
9. Now export this version of the image.

Again, this is unnecessary if you are using ImageJ, Photoshop, Huygens, Image Pro, etc.

5.3 Opening your Files.
Some commercial software applications will open the Olympus .oib and .oif formats, e.g. Imaris,
Slidebook and Fluoview. The Huygens software will only open the .oif format. Any image processing
application can import the tiff files found in the .oif format. See the document on importing Olympus
5.3.1 **Olympus free file viewer**

Olympus has a free file viewer for Windows that can open .oif and .oib files. However, it only allows you to view files and export the images to other formats, such as TIFF or JPEG. This application may be copied and installed on computers in your lab. It only runs on Windows because Olympus forces really smart programmers to work under really lame management.

5.3.2 **Offline Fluoview workstation**

A fully featured Fluoview workstation is installed on the ‘Fluoview Mac Pro’ confocal server. This provides all functionality available at the confocal, except acquiring an image. This workstation should be utilized for stitching mosaic images, spectral unmixing, image review or renaming Olympus files and other time-intensive operations that would otherwise require additional time on the confocal.

The Fluoview Mac Pro runs Windows7 under the Fusion environment. Click on the Fusion icon in the OSX dock to start Windows7. Login to Windows is the same as for the Mac Pro. After starting Fluoview software, select the ‘Guest’ user and leave the password blank.

5.4 **Importing Olympus datasets into ImageJ.**

5.4.1 **Loci-tools Plugin for ImageJ.**

The LOCI plugin will import about 80 file formats, including OIB and OIF. You will be presented with choices for merging or splitting channels and managing the color and histogram.

1. ImageJ>Plugins>LOCI>Bio-Formats Importer
2. Select desired confocal file to open.
3. Set View stack with: ‘Hyperstack’
4. De-select ‘Autoscale’
5. Set Color mode: ‘Custom’
6. A set of 3 sliders to mix Red, Green and Blue will appear for each channel in the image
7. Drag the sliders to set the color for each channel.
8. Click on ‘OK’.

5.4.2 **Import Channel Order Macro.**

This macro was written by DMC staff to import OIF and OIB files with control over assignment of channels to display colors, automatic creation of RGB projections and conversion of Olympus files into other file formats. The macro and full documentation is available from the ImageJ section of our website. The LOCI plugin is required.

5.4.3 **Image 5D plugin.**

Multi-channel 4D datasets can also be imported into ImageJ using the “Image 5D” plugin freely available from the the ImageJ website, rsb.info.nih.gov/ij.
5.4.4 *File Import from the OIF Files directory.*

ImageJ can import each channel of 16-bit TIFFS as a separate stack from the ‘Image>Import>Image Sequence...’ command. This is described on the DMC website.

5.5 *File Transfer.*

DO NOT PLUG ANY EXTERNAL STORAGE DEVICE INTO THE FV-1000 COMPUTER! This includes flash drives as well as hard drives. Such devices are serious sources of computer viruses.

The computer for this confocal is connected by 1000baseT ethernet to the Mac Pro sitting in front of the window. The confocal is not connected to the building network and its USB ports are disconnected. Files are saved to the internal hard drive on the confocal and then transferred to the Fluoview server.

Files are stored on a volume named “FV-1000 Files” on the Mac Pro server named “Fluoview”.

5.5.1 *File transfer to Mac Pro ‘Fluoview’, confocal file server.*

1. Connect to the server: double-click on “Shortcut to ‘(10.0.0.2) Z:’” icon on the confocal desktop;
2. Select the directory for your laboratory and appropriate sub-directory;
3. Open your confocal account: double-click on the “User Files” shortcut on the confocal desktop;
4. Navigate to your user account and the ‘Files’ directory located in Drive D;
5. Drag your confocal files from the User files directory to your directory in the Mac Pro;
6. Delete your old files from the confocal user directory when transfer is complete.

Full path to confocal user files:
D:\FV10-ASW\Users\<laboratory name>\Image\`

5.5.2 *Saving files directly to Mac Pro ‘Fluoview’.*

1. Acquire a file with the confocal;
2. Save the file;
3. At the save dialog window, navigate to “Z: 'FV-1000 Files (10.0.0.2)’”;
4. Navigate to the desired directory;
5. Save file.
6. All further image files will be saved directly to the Mac Pro server.

5.5.3 *USB and Firewire Ports on the Mac Pro.*

Ports on the front of the Mac Pro and rear of its monitor may be used for memory sticks and portable personal hard drives.

*Windows users:* Do not remove portable devices without EJECTING them first! Click on your device to highlight it then File Menu>Eject [device name] or right click on the device.

An eSATA port is located on the back of the computer for high speed external hard drives.
Flash drives are OS independent. Hard drives formatted for Windows will not work on the Mac unless you have switched to Windows with Fusion. Click on the Fusion icon in the OSX dock to start Windows7. Login to Windows is the same as for the Mac Pro.

5.5.4 Recording to CD-ROM and DVD-ROM on the Mac Pro.

DO NOT use the optical drive on the confocal.
1. Arrange your files and directories as desired within a directory on the FV-1000 Files volume;
2. Place a blank optical disk into the drive on the Mac Pro;
   a. Open drive bay by pressing the fat arrow key on the keyboard, above the ‘Delete’ key
3. Double click on the optical disk icon to open its window;
4. Drag the files into the disk window;
5. Arrange and rename the files, as needed;
6. Choose File->'Burn [disk]', and follow the instructions.
7. Eject the disk when done.

5.5.5 Networked file transfer to remote servers from the Fluoview Mac Pro

1. Click on the desktop, or on any directory;
2. "Go" menu;
3. "Connect to Server...";
4. Select your server by 1 of 3 methods:
   a. select from the list of favorites
   b. type in your server address (name or TCP/IP address)
   c. 'Browse' the network

5.5.6 Using FTP to Windows computers

1. FTP transfer to your server from Fluoview Mac Pro by the "Fetch" application.
   Look for an icon of a brown dog in the Dock at the bottom of the screen.

5.5.7 Remote access to the Mac Pro from your laboratory.

1. Log in by Apple File Sharing (from Mac) or FTP (from Windows).
2. Contact facility staff for log in information.
3. If you are not on a UW campus network, you will need to provide facility staff with the IP address for your computer

Your lab does not have a server? Perhaps your department provides server access for its faculty. Any Macintosh or Linux computer with a fixed IP address can be easily set up to function as a FTP server. Windows is not as easy, but doable. Peer-to-peer file sharing varies depending upon firewalls.

Server space is available within the DMC for users who need storage for their files for the duration of image processing needs or the duration of an experiment.
6. Optimizing Image Collection

The definition of “best” image will depend on the purpose(s) of the image and the nature of the specimen. Sometimes the characteristics of a “best” image must be sacrificed in order to achieve more important goals. A “pretty” picture is rarely suitable for quantitation or accurate representation of the biology. Conversely, an image optimized for data is rarely pretty.

6.1 Qualities of an Optimal Confocal Image.

- low noise
- high specific (desired) signal
- minimal bleedthrough between channels (spectral separation)
- low background
- high contrast
- full dynamic range
- absence of saturated pixels, at least in regions of importance
- absence of pixels with intensity values of zero
- absence of photobleaching or phototoxicity artifacts
- spatial resolution
- temporal resolution

These qualities are contradictory and compromises are required to achieve the “best” image from any given specimen.

6.1.1 Overview of image capture properties

1. Try to keep ‘HV’ below 750 to minimize detector noise, or use averaging;
2. Minimize laser power levels to reduce bleedthrough and photobleaching;
3. Channel ‘Offset’ should be adjusted to remove blue pixels, usually ~5 to 7;
4. HV and laser power levels should avoid saturation (red mask);
5. Establish imaging conditions using monochrome display rather than color;
6. Determine how much resolution is required.
7. Collect some trial to test your parameters and possible changes.

6.2 Overview of basic image capture.

Several parameters must be balanced for optimal images including PMT settings, laser power, filter selection, box size, zoom, choice of objective and dwell time.

There is no magic button on a confocal that will automatically provide the “best” image for you. Any combination of settings that are appropriate for a given specimen and intended use of the images will probably not be appropriate for a different specimen, different specimen preparation or different use of the images. Therefore, it is important to understand how the confocal microscope works and employ adequate control specimens.

6.2.1 Basic settings for confocal microscopy

1. Select dyes;
2. Find the specimen with the eyepieces with epi-fluorescence or transmitted light;
3. Set the Live Window to ‘Tile Display’;
4. Press ‘control-h’ to set the look-up tables (LUT) to gray scale;
5. Select zoom setting and box size (zoom = 1 and box = 512 are good starting points);
6. Raise PMT HV to about 1000 V;
7. Set to Simultaneous capture;
8. Collect image with Scanx2 or ScanX4;
   a. bring specimen into focus and frame the field
9. Choose Sequential capture, Frame (see below);
10. Select each channel group in turn and scan at ScanX2:
    a. minimize laser intensity while adjusting PMTs to less than 750 V to minimize saturated pixels (red)
    b. set Offset to eliminate pixels with an intensity of zero (blue)
    c. leave Gain set to 1
11. Select pixel dwell time for image collection, 2 µs is a good starting point;
12. [Optional] choose Kalman averaging (see below);
13. Capture image with XY button.

6.3 **Labeling Controls.**
Labeling controls are essential in determining acquisition settings and avoiding artifactual images. Control specimens also can save hours of work by helping to pinpoint the source of problems.

6.3.1 **Negative controls**
Negative controls, lacking primary antibody, are essential to determine degree of autofluorescence, background labeling or bleedthrough. Samples with no exposure to secondary antibodies or using antibodies subjected to immuno-absorption are also useful.

6.3.2 **Positive controls**
Known positive controls are also important. Positive controls labeled for each single label are crucial when imaging specimens with multiple labels. They can verify that the labeling protocol is working, and avoid wasting hours on the confocal looking for non-existent labeling. Single label controls also help in tracking sources of bleedthrough.

6.4 **The confocal aperture**
The confocal aperture (also called “pinhole” or “iris”) controls the amount of light rejected from out of focus regions. It should be set at the lowest setting consistent with the nature of the sample and your image requirements. Smaller iris diameters provide improved contrast and thinner optical sections. A wider iris increases the amount of out-of-focus light collected, the thickness of the optical section and reduces contrast. Diameters less than 1 Airy disk have no meaningful effect with air objectives having NA less than 0.9.

6.4.1 **Optimal Iris Diameter**
The optimal iris diameter matches the diameter of the outer edge of the first dark ring of the Airy disk, at the detector (refer to textbooks for more discussion). This is generally considered the diameter of 1 Airy
An iris set to this size passes approximately 80% of incident emissions and achieves a 20% increase in lateral and axial resolution, relative to the widefield microscope. The ‘Auto CA’ button (Figure 4.10) sets the aperture to 1 Airy disk diameter for the middle wavelength for multi-channel imaging. A diameter less than the optimal will provide moderately increased resolution with greatly reduced signal intensity. A larger than optimal diameter will decrease the resolution, while greatly increasing the contributions of out of focus light to the signal. However, a relatively large pinhole may be necessary to collect enough weak signals or to employ low laser intensities, conditions often encountered when imaging live cells. Deconvolution can be used to regain the resolution “lost” in the additional out of focus light.

### 6.5 Bleedthrough

The emission spectrum of a fluorophore is a roughly bell-shaped curve describing the probability that any emitted photon will possess a particular wavelength. Each fluorophore has a wavelength of maximal probability with declining probability curves extending into both longer and shorter wavelengths. Bleedthrough occurs when the emission curve from one fluorescent label overlaps an adjacent channel with sufficient intensity to appear in that channel’s image. Although, it is important to select fluorophores with minimal spectral overlap, bleedthrough is affected by both the signal intensity of the bleedthrough source and by the degree of amplification of the channel(s) in which the bleedthrough is observed. High excitation intensity will cause the low probability tails of an emission spectrum to reach detectable levels in adjacent channels for most combinations of labels. Additionally, setting a channel’s detector for high amplification levels will amplify signal from any overlapping emission spectra to create a significant bleedthrough. Another source of bleedthrough arises from over-labeling the specimen.

Bleedthrough also may occur when the excitation light intended for one channel also excites some other fluorescent label possessing an overlapping emission spectrum. Although such overlaps of excitation or emission spectra are usually minimal, they may still give artifactual images.

#### 6.5.1 Reducing bleedthrough

1. Reduce label concentration.
2. Select fluorescent labels with adequate separation of excitation and emission spectra
3. Minimize laser strength
   a. high excitation power increases the output of photons across the entire emission spectrum
4. Use appropriate filters
   a. longpass filters and wide bandpass filters allow signal overlap
   b. modern filters with steep ‘cut-on” and “cut-off” angles are recommended

#### 6.5.2 Procedure to minimize bleedthrough

1. Set the confocal for the multiple channels, same as to be used in the experiment;
   a. ensure consistency with the filters and dichroics
2. Select to image with Sequential, Frame;
3. Select the positive control for each channel, in turn, and optimize parameters;
   a. select the appropriate channel for the control
b. optimize the laser and channel parameters
4. Repeat step 3 with each negative control, adjust laser power and channel settings;
a. negative labeling controls should not display a specific signal
5. Image each positive control specimen in the other channels without changing their optimized parameters, after completing step 4;
6. If a positive control appears in another channel, adjust to laser power and the channel settings to reduce the bleedthrough to acceptable levels
7. Rescan the positive controls using the current settings, if anything changed in steps 5, 6 or 7;
8. Evaluate image quality for acceptable signal strength, noise and other parameters;
a. do you have to make compromises to obtain acceptable signal strength, noise levels, etc?
9. Examine an experimental specimen with all labels;
a. do you have to make compromises to obtain acceptable signal strength, noise levels, etc?
10. Capture images.

6.6 Noise.

Noise reduces spatial resolution and contrast. The 2 major noise sources for confocal microscopy are the statistical variation in the number of photons emitted from each sample point (shot noise) and the detector noise. Noise will occur in all pixels and in the signals from label as well as from background. It is generally reduced by avoiding low signal intensities, high PMT HV settings, use of Kalman averaging and by deconvolution.

6.6.1 Signal Noise (Shot Noise).

The number of photons recorded by the detector from each sample point in the specimen varies by +/- the square root of the number photons from the mean of the population. This variation represents 1 standard deviation on each side of the mean number of photons. This translates into the reality that the signal will lie somewhere within this range 68% of the time. Shot noise results in greater variability for low intensity pixels representing fewer photons.

Shot noise is reduced by increasing the number of photons contributing to the signal either by increasing signal or by averaging multiple images. Signal strength might be increased, with significant tradeoffs, by using higher laser power, longer dwell times, high NA objectives or increased staining levels. The amount of signal obtained by increased application of excitation decreases as the fluorophores begin to saturate and undergo photobleaching. Averaging is discussed in section 6.6.3.

The maximum intensity in a typical confocal image represents only 25 photons. The shot noise in the brightest pixels will be 25+/- 5 photons, or variation of +/- 20%. If the HV is set so that a maximum signal of 25 photons creates an intensity of 4,000, then the signal will vary between 3,000 and 5,000 (saturated) for 68% of the times that the specimen is scanned and fall outside of this range 32% of the time. Dark areas display greater variations in pixel values due to shot noise representing a larger portion of the signal. If a moderate intensity pixel represents 9 photons, its shot noise will result in a 33% variation in signal.
6.6.2 Detector Noise.
The HV setting on the PMT controls the likelihood photo-electrons will be accumulated and the degree of signal amplification. When the HV is raised, electrons will begin to spontaneously jump between anode stages (amplification stages) in the PMT. These spontaneous electron movements create random intensities that add to the signal output at random times. These appear as random intensity variations in the image with no relationship to the specimen signal. Keeping the HV below 750 is highly recommended to avoid detector noise.

6.6.3 Kalman Averaging.
Noise is a random event that can be reduced by averaging multiple images. The amount of noise reduction in the final image is the square root of the number of scans. There is a diminishing return to increasing the number of scans, for example, 2 scans will reduce noise by a factor of 1.41, but 9 scans reduces noise by only a factor of 3. However, averaging only 2 or 3 images can have a dramatic impact on images with high noise, regardless of origin. The tradeoff is that repeated scanning causes photobleaching, which can be mitigated by using reduced laser power. The averaging method of Kalman is commonly employed in microscopy. Averaging frames acquired with reduced laser power and increased HV may be useful with weak or photosensitive samples. The FV-1000 generally does not require averaging with relatively bright images.

6.7 Background
Background is an imprecise term for intensities that can not be attributed to specific (or desired) label signal. Background reduces contrast and dynamic range, interferes with computerized feature recognition and image processing. Sources of background signal include autofluorescence from tissue, fixatives, specimen preparation or culture reagents, non-specific antibody binding, non-specific label binding, reflections and bleedthrough. Background elevates signals and adds noise to the image as shot noise and detector noise are superimposed on background signal.

6.8 Bright Images versus Scorching the Specimen
Everyone wants “bright” images with high intensity pixels that stand out against the non-specific background intensities. Striving for “brighter” images through increased laser power or dwell time will always result in photobleaching and usually give increased background due to autofluorescence and bleedthrough. Raising the PMT’s HV will increase noise to reduce resolution and the SNR, unless accompanied by lowered laser intensity and averaging.

The labeled structures in your images only need to display intensities that are high enough to be distinguished from background and noise. Intensity of the image on the monitor or print can be adjusted by histogram stretch, offset and gamma adjustments in software.

6.9 Images with Weak Signals
Images can be obtained from specimens that are weakly fluorescent or prone to photobleaching or phototoxicity. Each approach has trade-offs that must balanced.
Increased laser power – stronger excitation of fluorophores, with disadvantages of photobleaching, bleedthrough and autofluorescence.

Longer dwell time - increases the signal by exciting each sample point in the specimen for a longer period of time, but provides similar disadvantages as higher laser power;

Higher HV – amplify the signal at the risk of detector noise.

Gain – multiplies the signal, however, background and noise will be amplified. Not recommended.

Photon Counting - accumulate very weak signals to detect individual photon events with very high S/N.

Change lenses – higher NA objectives focus more light into the image plane for greater excitation levels, and collect more light from the emission due to their greater acceptance angle; Fluor and Achromat objectives have greater light transmissivity than Plan, Planapochromat and lenses with phase contrast rings. On the other hand, lower magnification lenses acquire light from a larger area.

6.10 Using Zoom

Zoom is essential for getting the maximum resolution from a confocal microscope. However, use a few standard zoom settings, such as 2X, 4X, 8X, for your work. Resist the urge to use random zoom settings that make more work for yourself by constantly needing to recalculate scale bars and re-scale images to allow direct comparisons between images.

The zoom setting on a confocal is not a digital zoom. It physically alters the size of the area scanned by the laser spot and in doing so, changes the sampling rate for the image. Zoom provides additional resolution without the need to increase magnification, as with a widefield microscope and camera.

6.10.1 Zoom reduces objective lens aberrations.

A zoom setting of 2.0X will improve the image quality by collecting images from the central portion of the objective’s field of view. Zoom allows avoiding chromatic and spherical aberrations that are most serious at the edges of the lens. Objective lenses without flatfield corrections, such as Achromats, benefit greatly from using zoom.

6.10.2 Use Zoom to fulfill sampling requirements for the specimen.

The Nyquist Theorem requires that an object must be sampled at a frequency at least 2.3 times its size in order to be completely resolved. In other words, a 0.5 µm diameter mitochondrion, or two fluorescently labeled membranes separated by 0.5 µm, cannot be completely resolved unless viewed with pixels that are at least 0.217 µm, or smaller (0.5 µm/2.3).

If the object to be resolved is 6 µm, then the sampling interval only needs a pixel size of 2.6 µm. Bear in mind however, that software recognition may require higher resolution than the human eye.

6.10.3 Use Zoom to fulfill adequately sample the objective.

Similarly, if an objective lens has a lateral resolution of 0.5 µm, then the confocal zoom and box size must be set to a pixel size of 0.217 µm in order to record the finest details that can be
resolved by that objective. Using a zoom setting to create lateral resolution in beyond Nyquist will not improve the resolution of a confocal image. However, the exception is collecting images at 2X Nyquist, or 4.6 times the objective resolution, can be useful for deconvolution.

6.11 Obtaining a Z-Series.

The axial resolution for an objective lens is generally 2 to 5 times poorer than the lateral resolution due to spherical aberrations in the optical path and sample. The sample must be oversampled in the z-axis in order to achieve maximal resolution, just is is required in the lateral axes. The Fluoview software calculates the optimal z-step for each combination of objective and wavelength.

The focus steps for objectives in the table below provide sampling to match the Nyquist theorem for resolution. Smaller values will result in oversampling that may increase detectible resolution at the expense of inflated file sizes and additional photobleaching.

<table>
<thead>
<tr>
<th>Objective Mag.</th>
<th>Resolution (um)</th>
<th>Optimal Sampling (um)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lateral</td>
<td>Axial</td>
</tr>
<tr>
<td>4X</td>
<td>1.504</td>
<td>54.258</td>
</tr>
<tr>
<td>10X/.40</td>
<td>0.601</td>
<td>8.56</td>
</tr>
<tr>
<td>20X/.75</td>
<td>0.319</td>
<td>2.12</td>
</tr>
<tr>
<td>40X/1.30 Oil</td>
<td>0.181</td>
<td>0.948</td>
</tr>
<tr>
<td>60X/1.35 Oil</td>
<td>0.168</td>
<td>0.778</td>
</tr>
<tr>
<td>100X/1.4 Oil</td>
<td></td>
<td></td>
</tr>
<tr>
<td>60X/1.20 Water</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The resolutions calculated by the Fluoview software tend to be somewhat pessimistic. Axial resolution is improved by reducing the z-step to 1/2 of these values.

6.12 Resolution.

The lateral and axial resolution limits of the objective lens is set by its NA, not by its magnification. The resolution limits for any lens are constrained by wavelength, specimen preparation, signal intensity, noise and sampling frequency. Sampling and resolution on the confocal are properties of zoom and box size. Most biological specimens do not possess optical properties

Resolution can be defined in 2 ways: 1) How much can you resolve with any given objective lens, 2) How much resolution do you need to answer your questions? If you are looking for cells that can be identified by labeling in nuclei that are 5 µm in diameter, then you do not need the same resolution as if you are looking for synapses.
Since NA determines the smallest resolvable object, and the magnification magnifies that object, a pair of objectives with the same NA, e.g. 20X and 40X, will provide the same resolution. Magnification can be compensated by use of zoom and box size. In fact, a 40X objective would only provide 1/2 the field area of a 20X objective. However, use of a 20X lens with a 2X zoom would give the equivalent of a 40X objective in magnification and field size.

6.12.1 Sampling frequency and the Nyquist Theorem.

The Nyquist Theorem holds that any signal must be sampled at minimum of 2.3 times its frequency in order to record it without loss of information. This means that the resolving power of a given objective lens will not be recorded unless the sampling interval is at least 2.3 times smaller. If a lens can resolve 2 objects separated by 0.460 \( \mu m \), then it must be sampled at 0.460/2.3 or 0.200 \( \mu m \) per sample point (\( \mu m \) per pixel, in the image). Sampling with a larger pixel size will cause “aliasing” and a smaller pixel size will result in “oversampling”.

Aliasing will cause a structure to change its appearance depending upon how it is aligned with the sampling interval. Oversampling may or may not provide additional information but will impose additional scanning time and laser exposure. However, oversampling by 2X, or a sampling interval at twice Nyquist (4.6 times the frequency (size) of the structures to be resolved) is necessary for maximal resolution of structure shapes and is beneficial for deconvolution.

6.12.2 Box size.

This term refers to the number of sampling points in the scanned field. A box size of 512x512 means that the field will be divided into 512 samples along each of 512 lines. If the lines in the scanned field are 300 \( \mu m \) long, then the pixel size is about 0.6 \( \mu m \). If the box size is increased to 1024 x1024, then that 300 \( \mu m \) is now divided into 1024 samples, each approx. 0.3 \( \mu m \) in size.

6.12.3 Zoom.

Zoom controls the size of the region scanned in the objective’s field of view by limiting the distance over which the laser beam is deflected by the scan mirrors. The scanned region is divided into a number of sampling points determined by the box size. If the full field of view at zoom = 1 is 300 \( \mu m \) and divided into 512 sampling points per line, then each pixel represents 0.6 \( \mu m \). But, if the zoom is doubled, then line is only 150 \( \mu m \) in length and each pixel represents 0.3 \( \mu m \). A zoom = 2 combined with box size increased to 1024 produces pixels of only 0.15 \( \mu m \).

6.12.4 Considerations for increasing resolution.

1. Smaller pixels require obtaining signal from smaller volumes in the sample which, in turn, possess fewer fluorophores to generate signal.
2. When zooming, the same amount of laser power is now applied to a smaller region, which is likely to increase photobleaching.
3. Higher resolution is also dependent upon sample preparation, which may be a limiting factor.
4. Increasing the box size increases the size of the files. A 16-bit image of 512x512 is saved at 0.5 Mb, whereas an image of 1024x1024 contains is 2.1 Mb.
5. Box size increases resolution while maintaining the field of view. Increasing the zoom without changing the box size will decrease the field of view.

6.13 Size of Pixels

The magnification and pixel size of an image is a function of lens magnification, box size and zoom factor. However, these values will change slightly after any major alignment of the instrument.

Table 5 Pixel Size (µm) versus Box Size and Magnification at Zoom = 1

<table>
<thead>
<tr>
<th>Box Size</th>
<th>4X</th>
<th>10X</th>
<th>20X</th>
<th>40X</th>
<th>60X</th>
</tr>
</thead>
<tbody>
<tr>
<td>64x64</td>
<td>4.971</td>
<td>2.485</td>
<td>1.242</td>
<td>0.828</td>
<td></td>
</tr>
<tr>
<td>128x128</td>
<td>4.971</td>
<td>2.485</td>
<td>1.242</td>
<td>0.828</td>
<td></td>
</tr>
<tr>
<td>256x256</td>
<td>4.971</td>
<td>2.485</td>
<td>1.242</td>
<td>0.828</td>
<td></td>
</tr>
<tr>
<td>320x320</td>
<td>3.977</td>
<td>1.988</td>
<td>0.994</td>
<td>0.994</td>
<td></td>
</tr>
<tr>
<td>512x512</td>
<td>2.484</td>
<td>1.242</td>
<td>0.621</td>
<td>0.414</td>
<td></td>
</tr>
<tr>
<td>640x640</td>
<td>1.985</td>
<td>0.994</td>
<td>0.497</td>
<td>0.331</td>
<td></td>
</tr>
<tr>
<td>800x800</td>
<td>1.590</td>
<td>0.795</td>
<td>0.397</td>
<td>0.265</td>
<td></td>
</tr>
<tr>
<td>1024x1024</td>
<td>1.242</td>
<td>0.621</td>
<td>0.310</td>
<td>0.207</td>
<td></td>
</tr>
<tr>
<td>1600x1600</td>
<td>0.795</td>
<td>0.397</td>
<td>0.198</td>
<td>0.132</td>
<td></td>
</tr>
<tr>
<td>2048x2048</td>
<td>0.621</td>
<td>0.310</td>
<td>0.155</td>
<td>0.103</td>
<td></td>
</tr>
<tr>
<td>4096x4096</td>
<td>0.310</td>
<td>0.155</td>
<td>0.103</td>
<td>0.051</td>
<td></td>
</tr>
</tbody>
</table>

The size of a pixel in a zoomed image is obtained by dividing the value from the above table by the zoom factor. Shifting from a 512x512 to a 1024x1024 box size has the same effect on pixel size as doubling the zoom factor. However, the 1024x1024 box will record a larger field of view, which may be crucial for a given experiment.

Pixel Size = (Pixel size, Zoom = 1)/zoom factor.

e.g., 40X objective, 512x512,
zoom = 1, pixel size is 0.621 µm;
zoom = 4, pixel size is 0.621/4 = 0.155 µm/pixel

Size of image = (Box size) X microns per pixel.

e.g. 512 x 512 box, imaged with 20X objective, zoom = 1:
(512 pixels)(1.242 micron/pixel) = 635.904 microns width and height;
Divide this by the zoom factor to compensate for zoom.
Theoretical lateral resolution: \( \frac{\text{wavelength(nm)}}{2(\text{NA})} \)

Wavelength = emission, in nanometers, usually the central wavelength of the emission band of the barrier filter.
NA = numerical aperture of the objective lens.
Examples:
Using a 20X/NA0.75 objective with the green channel, 540 nm/2X.75 = 540 nm/1.5 = 360 nm lateral resolution (0.36 \( \mu \)m).

Zoom factor for 2X oversampling = \( \frac{\text{Pixel size}}{\text{(wavelength)(NA)}} \)
7. Microscope controls.
There are a few manual controls

7.1 Focus.
The IX-81 has a single focus knob, Figure 12.1, on each side of the stand. It is used for both coarse and fine focus.

7.1.1 Fine/Coarse Focus.
Press the F/C button, Figure 12.2, adjacent to the focus knob to toggle between coarse and fine focus settings.

7.1.2 Lowering the Objectives.
Press the ESC button, Figure 12.3, adjacent to the focus knob, to drop the objective or raise it back to the focus position. This is important when changing samples or stage inserts to avoid damaging the objective. The microscope controller will not change objectives if the objective turret is in the dropped position. Occasionally, the turret will not raise back, in this case switch to coarse focus to bring the objective close to focus then switch back to fine focus.

7.1.3 Manual shutter.
This manual shutter allows blocking quickly either the laser beam or the mercury lamp. Push the lever away from you to close the shutter (solid circle) and pull it towards you to open the shutter (open circle).

7.2 Differential Interference Contrast (DIC).
This enables high contrast, high resolution images by transmitted light from samples that are only stained with fluorescent labels. Using DIC greatly reduces photobleaching while locating the sample or a region of interest. There are 2 components to be manually adjusted for DIC - Koehler illumination and the DIC analyzer. Setting Koehler illumination is essential if collecting an image with the confocal’s transmitted light detector.

7.2.1 DIC Analyzer.
This is on a slider below the objective lens turret, Figure 12.4. This should be pulled out during routine confocal imaging to remove it from the optical path. The analyzer will reduce fluorescent signal strength, create reflections and distort the image, reducing resolution! The degree of DIC contrast is adjusted with the knob, Figure 12.6. The DIC contrast is greatest with the knob at the midpoint of its motion and least with the knob at either extreme of its rotation. You might want to use the locking screw, Figure 12.5 to prevent the analyzer from accidentally being pushed into the light path.
7.2.2 DIC polarizer.
This is on the condenser, Figure 13.4. This must be slid into the halogen path in order to obtain a DIC image. Pull it out to obtain a plain brightfield image. The position of the polarizer has no effect on confocal fluorescent imaging.

7.2.3 DIC mirror.
This component is controlled automatically by the Microscope Controller. Selecting the DICT button also rotates a wheel in the condenser that rotates the appropriate Wallaston prism into place.

7.3 Setting Koehler Illumination.
Maximal resolution and field uniformity with brightfield and DIC is only achieved if the condenser is in focus to the same plane as the objective lens. Also, a focused condenser acts as the condenser lens for the transmitted light detector. A properly configured condenser will make brightfield or DIC much more...
effective in finding your sample without subjecting it to fluorescence. Focus of the condenser may need to be re-adjusted if changing the level of focus in the sample or after switching objectives.

1. Place a sample on the stage and obtain an image using brightfield or DIC to the best possible focus.
2. Make sure the Condenser Aperture Diaphragm, Figure 13.1 is fully open by moving the black lever fully to the left;
3. Observe through the eyepieces as the Field Stop Diaphragm, Figure 13.3, is closed down by moving the black lever to the right;
4. If closing the field stop blocks the light, stop and use the 2 centering screws, Figure 13.5, to move the aperture image back into view.
5. Once the Field Stop is fully closed, rotate the condenser focus knob, Figure 13.2, until the edges of the iris are as sharp as possible;
6. Use the centering screws to move the field stop into the center of the field of view;
7. Open the field stop just until the edges almost disappear from the field of view;
8. Now, close down the condenser aperture diaphragm just until you begin to see the image dim slightly, then nudge it back open until the light intensity is restored;
9. Check the focus of the sample, it may change if the condenser was initially out of focus;
10. If the focus was changed, re-check the condenser by simply closing the field stop and finely adjusting the condenser focus, then re-open the field stop;
11. Now, the condenser is properly adjusted, for this objective lens, to provide sharp transmitted light images or to direct unabsorbed laser light to the transmitted light detector.
12. If collecting an image with the transmitted light detector for confocal imaging, focus on some level within the specimen by confocal. Then switch to transmitted light imaging through the eyepieces to set Koehler illumination.

7.3.1 Condenser position.

The condenser is moved out of the way for inserting a specimen by either turning the condenser focus knob or by tilting. It tilts on a hinge located behind it, at the support. It must be in the horizontal position for any procedure requiring transmitted light. Keep it tilted down in working position when performing confocal microscopy to avoid the possibility of vibration should it slip down on its own.
8. **Photoactivation Methods.**

Several imaging procedures involve the application of light in various combinations of wavelength, intensity, duration and region of interest (ROI) in order to promote a reaction. Common applications include photoactivation of fluorescent proteins, photobleaching fluorophores and photoablation of cells.

Two important aspects of photoactivation methods are control over activation energy levels and the onset of image collection after activation. The activation energy exposure must be controlled to avoid bleaching the reporter label before it can be recorded. Fluorescent recovery after photobleaching (FRAP) is often concerned with determining the recovery rate of the targeted fluorophore. Delays in switching from bleaching to recording may prevent acquisition of the initial 100 ms to 1 sec of recovery essential for determining an accurate recovery rate. The best way to achieve rapid acquisition of the bleach image is to use a confocal equipped with an independent scanner such that the main scanhead is recording an image while the secondary scanhead is performing the bleaching or photoactivation without any delay. However, it is possible to record images during photoactivation and immediately afterwards if the photoactivation does not require changes to the optical path, such as zoom, dichroic filters, etc.

8.1 **Zoom versus Laser Power.**

Setting the Zoom to a value greater than Zoom=1 concentrates the laser power of into a much smaller volume. The result is that the photodynamic effects are achieved with much lower laser level and shorter exposure duration. However, manually zooming in to bleach, then zooming out to record will cost a few seconds delay between bleach and recording.

8.2 **Recording initial recovery event.**

The Stimulus Window allows performing photoactivation at the current scanning configuration. This may be performed separately from recording images, or may be performed in conjunction with a timelapse recording. So long as the scanning does not need to be interrupted to change optical settings such as zoom or dichroic mirrors, images can be recorded during the photoactivation.

For example, the confocal is set for Zoom=3 with the 60x water lens and a box of 512x512, 2 μs dwell time, and the Timecourse is set for 12 frames at 2 second intervals. Using the Stimulus window set for ‘Activation in Series’ with 2 pre-activation frames and 4 activation frames the confocal will record 2 frames of the unbleached sample 2 seconds apart, then scan the ROI 4 times to bleach or activate, 2 seconds apart, then collect 6 frames after the activation.

8.3 **Methods to photoactivate/bleach.**

8.3.1 **Using the Stimulus Window.**

The Stimulus window allows you to define an ROI on the sample and apply a selected level of laser energy within that ROI.
Figure 15. The Stimulus Setting window for photoactivation.

1. Select a field in the sample that contains 1 or more regions of interest;
2. Collect a scan of this field with the desired acquisition settings for each channel;
3. Set the Stimulus window settings as shown in Figure 15;
   a. ‘Use Scanner’ - choose ‘Main’, we don’t have a SIM scanner
   b. choose the ROI type and mark one or more ROIs on the Live Display window
      i. each bleach ROI will have “B” appended to the ROI number
   c. set the pixel dwell time for bleach scanning;
   d. ‘Laser’ - select one or more laser lines for bleaching, and their power level
   e. ‘Stimulate Start Setting’
      i. ‘Manual’ requires initiating scanning with the XY button and stopping with Scan Stop button
      ii. ‘Auto Stop’ halts bleaching after a given number of scans or a defined time period (ms)
   f. ‘Activation in Series’ - allows photoactivation operations in a sequence
      i. ‘PreActivation’ - record a specified number of images before activation
      ii. ‘Activation Time’ - Set number of scans or a defined time period (ms) for activation
         iii.a set of images after bleaching can be collected
4. The time interval between scans and number of total scans (including pre-bleach and bleach scans) is set by the Timecourse window;
5. Start a photobleach operation by setting the XY Scan button to “time” then begin an XYT operation;
6. The bleaching is stopped either by manually pressing the ‘Scan Stop’ button, or by reaching the stop points defined by the ‘Auto Stop’ setting or by the number of frames in the Timecourse window.

![Pre-bleach and Post-bleach images](image)

Figure 16. Photobleaching an ROI.
Timecourse: Freerun (no time interval between frames) for 12 frames.
Stimulus: Circular ROI, 4 µs dwell time, 405 nm laser line at 41%.
Activate in series set to 4 pre-bleach frames, 4 bleach frames, leaving 4 frames to be collected post-bleach.

8.3.2 Avoid spontaneous photoactivation.
A small percentage of photoactivatable fluorescent proteins in the sample will photoactivate when switching from epi-fluorescence to confocal imaging. Rotating the mirrors (filter cubes) to allow confocal scanning exposes the entire field of view to a brief flash of UV from the DAPI cube.

Close the manual shutter below the objective turret before switching from epi-fluorescence to confocal imaging.

8.4 Controlling Computer Display Brightness.
It is often important for one’s eyes to become dark-adapted in order to view the specimen through the eyepieces, or even on the computer display. Glare from the computer desktop and software windows can be a nuisance. The desktop display on the confocal computer has been set to black. The Fluoview software application has an option called “Darkroom” that will set the white background of all menus and windows to a dark gray. It does take getting used to the appearance.
8.4.1 Set ‘Darkroom’ color mode.

1. Move the cursor along the toolbar located just below the menus in Fluoview 2.1c;
2. Click on the tool bar item with the flyout label of “Darkroom color”, Figure 17.1;
3. Return to normal appearance by clicking on the adjacent tool bar item “redo work space color” Figure 17.2.
4. Be aware that menus and toolbar items are nearly impossible to see in Darkroom color mode.

Figure 17. The toolbar item for control over display color

Figure 18. Fluoview appearance in Darkroom Color.
9. Technical Information

9.1 Caring for Objectives

1. Check the turret before placing your sample in the holder or activating the Multi-Area TimeLapse module.
   a. If the lens appears to extend above the level where your specimen will be positioned then you must lower the objective lens with the focus knob.
2. If a specimen has been viewed with an oil immersion objective, THE 20X OBJECTIVE CANNOT BE USED until ALL oil has been removed from the specimen.
3. Remove immersion oil from the objectives after each imaging session
   a. Wick the oil from the glass lens with a sheet of lens paper folded double
   b. Wipe all of the oil from the metal nose of the objective using a Kimwipe
   c. Gently blot the lens with filter paper again.
   d. Inspect for, and wipe away, any oil running down the side of the objective.
4. Remove immersion oil from your specimen as soon as possible
   a. Gently wipe specimen with a Kimwipe then clean with 95% ethanol
5. When changing objectives (special operation with training required), insert and remove objectives after removing the stage insert and tilting the condenser back to get clearance.
6. Always lower the objective turret when changing samples.
7. Use high-viscosity immersion oil (>1200 centistokes, e.g. Cargille Type B) for the least spread of oil.
8. **Do not over-oil immersion objectives**, use the minimum amount of oil necessary.
   a. Scrunchies have been wrapped around the oil immersion objectives to absorb accidents
9. It is not necessary to rub the glass or to get it completely oil-free, a thin film of oil is acceptably clean.
10. **DO NOT MIX IMMERSION OILS FROM DIFFERENT BRANDS!!!!** This can create refractive index gradients that affect the image or cause chemical reactions that create serious problems.
11. Report all objective problems immediately!

9.2 FV-1000 Optical Specifications

This table shows the filters and beamsplitters used as dyes are selected. The excitation dichroics reflect the laser lines to the scanhead and allow the emissions to pass into the detectors. There are dichroic mirrors for the first 3 channels to direct emissions into the detectors. The 4th channel has a fixed mirror so that any signal passing through the preceding dichroics will be directed to the PMT. Channels 3 and 4 use standard barrier filters to limit the range of wavelengths reaching the detector. Channels 1 and 2 each use a diffraction grating with an adjustable slit to control the range of wavelengths allowed to reach the PMT.
Table 6. Dichroic Mirrors and Barrier Filters

<table>
<thead>
<tr>
<th>Excitation</th>
<th>Channel 1</th>
<th>Channel 2</th>
<th>Channel 3</th>
<th>Channel 3</th>
<th>Channel 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>BS 20/80</td>
<td>Mirror</td>
<td>Mirror</td>
<td>Mirror</td>
<td>BA 655-755</td>
<td>BA 655-755</td>
</tr>
<tr>
<td>DM 405/488</td>
<td>Glass</td>
<td>Glass</td>
<td>Glass</td>
<td>BA 585-685</td>
<td>None</td>
</tr>
<tr>
<td>DM 405/488/561/633</td>
<td>SDM 560</td>
<td>SDM 640</td>
<td>SDM 560</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>DM 458/515</td>
<td>SDM 510</td>
<td>SDM 560</td>
<td>SDM 640</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>DM 405-440/514</td>
<td>SDM 490</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>DM 558/561</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

The excitation dichroic controls which laser lines can be employed at the same time. For instance, the 488 and 515 lines cannot be combined because the 27 nm gap between them does not provide a sufficiently wide window for green fluorescence to return through the dichroic mirror. About 10 nm on each side of the potential emission window is needed to allow for filter efficiency.

Table 7. Laser Power through dichroics, measured at the lens turret, 100% output

<table>
<thead>
<tr>
<th>Dichroic Mirror</th>
<th>405 nm</th>
<th>458 nm</th>
<th>488 nm</th>
<th>515 nm</th>
<th>561 nm</th>
<th>633 nm</th>
</tr>
</thead>
<tbody>
<tr>
<td>BS20/80</td>
<td>161 µW</td>
<td>9.4 µW</td>
<td>23.5 µW</td>
<td>50 µW</td>
<td>45 µW</td>
<td>98 µW</td>
</tr>
<tr>
<td>BM405/488</td>
<td>414 µW</td>
<td>1 µW</td>
<td>102 µW</td>
<td>16 µW</td>
<td>1.2 µW</td>
<td>20.4 µW</td>
</tr>
<tr>
<td>BM405/488/561/633</td>
<td>414 µW</td>
<td>2.6 µW</td>
<td>104 µW</td>
<td>2.4 µW</td>
<td>114 µW</td>
<td>280 µW</td>
</tr>
<tr>
<td>BM458/515</td>
<td>306 µW</td>
<td>32 µW</td>
<td>3 µW</td>
<td>161 µW</td>
<td>10 µW</td>
<td>7.6 µW</td>
</tr>
<tr>
<td>BM405-440/515</td>
<td>414 µW</td>
<td>28.8 µW</td>
<td>0.6 µW</td>
<td>171.2 µW</td>
<td>54 µW</td>
<td>1.6 µW</td>
</tr>
<tr>
<td>BM458/561</td>
<td>362 µW</td>
<td>30.4 µW</td>
<td>1.6 µW</td>
<td>4.6 µW</td>
<td>164 µW</td>
<td>7 µW</td>
</tr>
</tbody>
</table>

The important points for this table are:
1) Most dichroics will reflect more lines than stated
2) Non-optimal lines may leak into detectors.

The BS20/80 dichroic reflects 20% of the incident excitation light and passes 80% of the reflected light to the detection optics.

Table 8. Index of Refraction for Common Mounting Materials

<table>
<thead>
<tr>
<th>Medium</th>
<th>Refractive Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air</td>
<td>1.000</td>
</tr>
<tr>
<td>Water</td>
<td>1.333</td>
</tr>
<tr>
<td>Glycerol</td>
<td>1.473</td>
</tr>
<tr>
<td>Immersion Oil</td>
<td>1.515</td>
</tr>
<tr>
<td>Cover Glass</td>
<td>1.518-1.525</td>
</tr>
</tbody>
</table>

Be aware that refractive index changes with temperature and wavelength.

May 11, 2011 49
10. **No Image!**

10.1 **Start-up problems.**
- Fluoview starts to load but stalls with the Fluoview workspace open - Is the microscope controller turned on? See Start-up protocol.
- Fluoview starts to load but stalls with a driver error – Is the Scan Control Unit turned on? See Start-up protocol.

10.2 **Scans, but no image.**
- Is the Mirror in microscope control window set to “LSM”?
- Is the selected laser turned on? Check the power strip, power supply key and rocker switch.
- The 405 nm laser has a toggle switch to open its internal shutter, did someone flip it and close the shutter?
- The 561 nm laser has a green button adjacent to its key that must be pushed to turn it on.
- Check the fluorophore selection (Dye List) – is it appropriate for your sample?
- Is the sample in focus? The depth of field for epifluorescence is much greater than for the confocal image.
- Is the manual shutter below the turret open or closed?
- Is the DIC analyzer partially in place and blocking the optical path?
- Use tungsten or mercury lamp to make sure that the sample is in position and focused.
- Is the laser intensity sufficient? If you can see the sample by epi-fluorescence, no more than 3 mW of laser power are usually required to get an image.
- Can the detector HV be increased?
- Has the detector Offset been increased? – This should be 5-7.
- Are you adjusting to the correct PMT and laser?
- Does the Confocal Aperture need to be opened up?
- Do you need to use special imaging methods for extremely low signal levels?
- Are you using the correct objective lens? non-immersion lens?
- Is there oil, glycerol, water, fingerprints, etc. on a dry lens?
- Do you have the correct immersion medium for your immersion lens?
- Can you observe any laser illumination coming through the objective lens?
- Is the Scan Control Unit on?
- Is the Scan Control Unit key turned to the on position – it controls a scanhead safety shutter.
- Has there been an earthquake recently? Components can be shaken out of position.

10.3 **The confocal image appears unevenly illuminated:**
- If focusing on an uneven surface or thin specimen, only part of the field will be in focus.
- If the slide is setting unevenly on the stage, sample surfaces will not be uniformly in focus.

10.4 **The epifluorescent or tungsten images appear unevenly illuminated:**
- The objective is dirty or there is an inappropriate immersion medium present.
- Unusually dim image - the mercury lamp aperture is closed.
- The mercury lamp arc may have shifted, facility staff will need to re-align the bulb.